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The Genealogy Road 
Warrior 

his article explains how the genealogist can be more effective on a genealogy trip.  
We start by discussing the computer-based tools that the genealogist needs on a 
genealogy trip then present the resources that are readily available to provide 

these needs.  We will see that the same computer tools used everyday by the genealogist 
are the very ones needed most on a genealogy trip.  Thus, this article will focus on 
adapting the genealogist’s daily computer-based tools set to the genealogy trip.  In 
particular, we will show you how to utilize your hosting services at 
www.genealogyhosting.com to make your genealogy trip as effective as possible. 

The Big Genealogy Index:  The Internet 
Every genealogist has a finely tuned genealogy tool set dominated by the computer but 
including hardcopy resources such as books, guides, maps, etc.  However, most of the 
great leads, the starting point for researching a topic, that a genealogist gets nowadays 
come in through the computer and in particular the web and e-mail.  This is because the 
big picture (Figure 1) is that the internet is “The Index” pointing to information in 
genealogy libraries, county repositories, archive centers, etc.  The internet is also the 
infrastructure of the human network, the e-mail exchanges among working genealogists.   

Most genealogy research starts by searching this big index, the internet, and leads to a 
trip to the source of the information, helped along the way by frequent e-mail 
communications with fellow genealogists.  The important point is that this picture does 
not change when on a genealogy trip – the tool set must still be accessible in the field 
and if anything, its use is much more intense.  

Notice that we are talking about the computer-based tool kit here and not the actual 
computer.  Public computers are almost always available at public libraries and research 
centers.  These public computers almost always provide access to the internet as well as 
the ability to get a day-pass to use them (i.e., if a library card is normally required).  
While the traveling genealogist often travels with a laptop computer, as we’ll see below, 
this isn’t the only solution nor always the best solution.  The trouble is that bring-your-
own computer hardware always has a time-consuming “fiddle-factor” which detracts 
from its use in the field (more later).  Thus, the major emphasis in this article will be to 
explain how the traveling genealogist can be effective using just the public computers in 
a library or research center. 
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This article shows how the genealogist of Figure 1 can be physically located anywhere in 
the world and still be as productive as ever.  We will show how the genealogist’s 
computer tool kit can be adapted so that it is always available on a trip. 

Also, we will point out the features of your web services account at 
www.genealogyhosting.com that you can use on a trip to improve your effectiveness in 
the field.  That is, your hosting services account already has several features that are 
very useful to the traveling genealogist.  Other useful services for the genealogy trip can 
be purchased for a small fee. 

 
Figure 1 - The Internet as “The Index” and the Communication Infrastructure 

So the computer-based tool kit is the primary resource of any genealogy tool set.  The 
effective use of the computer-based tool set, and in particular the web is what has to 
occur especially during a genealogy trip.   

What the Genealogist Needs on a Genealogy 
Trip 
To be effective, genealogists will need to have access to as much of their home tool set as 
possible when on the road. Obviously not all of the home tool set will be able to make 
the trip.  For example, those heavy reference books, how-to guides, and atlases will have 
to stay home for the most part.  However, as much of the genealogist’s computer tool set 
as possible must be available on the trip.   What are the daily computer tools that 
genealogists will need on a genealogy trip?  Here is a list of the genealogy “road 
warrior” tools: 
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E-mail system  

First and foremost, the traveling genealogist will need access to their e-mail account 
from any of the various computers they make use of on the trip.  When on a genealogy 
research trip, you are very focused, very dedicated, and you will need to communicate 
with your fellow researchers on the spot from the research site as you uncover 
information or have questions. 

Favorites  

The genealogist’s favorites (also called bookmarks) from their local internet browser 
(e.g., Internet Explorer, Netscape Navigator) must be available on the trip.  Nothing 
defines the genealogist’s computer tool set more.  The favorites are usually the major 
intellectual property that drives any research effort.  Favorites must be available to 
traveling genealogists from any computer on the trip so they can quickly and easily 
access their regular research websites. 

Genealogy Database 

Traveling genealogists must have the ability to view for quick reference the contents of 
their genealogy databases (i.e., the file from the genealogist’s genealogy software 
program such as PAF, Family Tree Maker, The Master Genealogist, etc.) from any 
computer on the trip.  The genealogy database will normally not be updated in the field 
but the genealogist will need to have quick access to it to check information. 

File Storage 

The traveling genealogist must be able to save files from any computer they happen to 
be using on the trip.  This happens all the time:  when at a computer in a library, you 
create a file such as cutting out part of an image or printing some output as a PDF file 
(i.e., instead of paper).  You want to store these files somewhere so you can retrieve 
them later when you get home. 

Quick Reference Files 

We all create quick reference files to help us in our daily genealogy research:  little 
Microsoft Excel files listing people with your surnames that fought in the Civil War; a 
Word document summarizing the major events and dates in the life of an ancestor; the 
dates that counties were formed in South Dakota, etc.  We all create these quick 
reference files to avoid repeatedly having to lookup the information in our files or 
reference books.  These customized reference sources must be available from any 
computer on the trip. 
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Trip Resources 
The items on the list could be provided by more than one kind of computer resource.  
Not only can genealogists take along computer equipment but also several resources 
from your www.genealogyhosting.com are available to provide the various parts of the 
traveling computer tool set.  In this section, we will list the various computer resources, 
both equipment and hosting services, that could be harnessed by the genealogy road 
warrior, some at considerable expense and some relatively cheap or even free. 

Laptops 

A laptop would go a long way in providing the list of resources above (assuming your 
laptop is not your main computer – if it is then you are all set).  The laptop could be 
loaded with your computer-based tool set prior to the trip so it would be available 
anytime on the trip.  You can set up your e-mail system on it and copy your favorites 
(bookmarks) to it from your main computer.  Then you could install your genealogy 
software program on it and copy your genealogy database to it.  Also, you would copy 
your quick reference files to it.  At this point you would have a good working replication 
of your normal genealogy tool set.  Laptops are great on a genealogy trip but they also 
have some problems: 

Using a Laptop on a Trip 

 When you are at a library, you would set up your work area, and access the internet 
using the wireless connection on your laptop or if necessary a network cable to a 
public network plug in the library.   

 For the most part, working on your laptop at the library would resemble working at 
home on your desktop computer. 

Problems with a Laptop 

 Laptops, like all computer equipment, have a high “fiddle-factor” – the time spent 
messing around with the equipment to get it positioned, hooked up, and 
operational.  This “fiddle-factor” time is always significant and represents the 
overhead of using a laptop. 

 You’re always having to guard your laptop so it won’t get stolen.  For example, you 
must monkey around with your anti-theft cable and when you are off in the stacks of 
the library, you are always worried about it and you are always subconsciously 
glancing over at it.  This is a real distraction. 

 It’s not guaranteed that a laptop will be able to access the internet at the location.  
While most of the big libraries have wireless hubs and even network ports (i.e., RJ45 
network plugs) available for public use with a network cable, many sites won’t have 
these capabilities.  For example, small libraries, county courthouses, or friends and 
relatives may not have network access for your laptop.  That is, while most people 
will have internet access on their own home computers, they won’t have the 
capability of providing network access to laptops to access the internet. 
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 The laptop is an isolated island.  The laptop can’t be used to store a file directly from 
one of the computers in the library.  Also, the information on the laptop can’t be 
shared directly and must be copied to a server if others are to view it.   

USB Flash Drives 

Everyone has one of those cute little USB flash drives.  You use it to store and retrieve 
files on the go.  Many of the items on the list above are related to the need to store and 
retrieve files in the field.  Why not just use your little USB flash drive for this?  A USB 
flash drive would be very useful on a genealogy trip but they also have a few problems 
as noted in the following:  

Using a USB Flash Drive 

 The USB drive is inserted in any available USB port on a computer in a research 
location.  Most large institutions will have public USB ports on their computers.  
These public USB ports, if they exist, are readily accessible for this purpose.  Once 
inserted, the USB flash drive is immediately recognized as a disk drive by the 
computer and you’re off and running.   

 Once it is inserted, the USB flash drive could be accessed like any disk drive by 
opening  “My Computer” and double clicking it in the list of drives.  This would 
cause a Windows Explorer to open exposing the list of files and folders stored on the 
USB flash drive.   

 Once it is inserted, the USB Flash drive can also be accessed from an application that 
the genealogist is using on the field computer.  For example, if the genealogist is 
using Microsoft Word on the computer in a library, then he or she can save the Word 
file on the USB drive by “File -> Save As…” then navigate to the target folder on the 
USB flash drive in the usual way. 

Problems with the USB Flash Drive 

 The USB Flash must first be inserted into the computer.  This means the computer 
must have an available USB port to plug it in.  Realistically this is not a problem in 
the big libraries and research institutions but it could be a problem on many other 
computers the genealogist encounters on a trip (e.g., old home computers of friends 
or relatives, county court houses or small rural libraries, etc.). 

 Windows Explorer is required to complete most file operations on the USB flash 
drive.  This is because to use the USB flash drive, the genealogist must be able to 
open a Windows Explorer on the field computer.  For example, genealogists would 
start Windows Explorer so they can navigate to the USB flash drive to access the files 
and folders there to open or save them.  However, sometimes the use of Windows 
Explorer is restricted in libraries or research centers since it represents a potential 
security risk. 

 The USB flash drive is easy to lose.  As the trip progresses, the USB flash drive 
accumulates more and more important information as the genealogist saves more 
and more information on it.  What if you forget to take it out of the USB port when 



 6 

©2007 www.genealogyhosting.com 

you are finished with the computer and you only discover it hours later when you 
are at the next library?  The result is a lot of wasted trip time.  What if you just plain 
loss it?  This would be a total lose of that part of the trip. 

 The USB flash drive has a “fiddle-factor” associated with it’s use – it is, after all, a 
hardware device.  When you first sit down at the computer in the research location, 
there is a time delay as you look for the port and then fiddle to insert it.  Once 
inserted, the computer may not recognize it and you have to reinsert it.  When 
something goes wrong on the computer, you wonder if it is caused by your USB 
flash drive. 

 The information on the USB flash drive can’t be shared directly and must be copied 
to a server if others are to view it.   

Your Genealogy Website 

Several of the items in the above list require file storage as their underlying enabling 
technology and in many cases the huge disk space (gigabyte sized) that comes with your 
“Economy” hosting plan can be used for this.   

Note – this resource would be limited in use for a “Website Tonight” website. 

Using your Genealogy Website 

 The genealogist could use their website disk space to upload and download files to 
or from private folders on the website (i.e., the files are not intended to be viewed on 
the website by the public). 

 The genealogist would use FTP to upload genealogy treasures from libraries or 
research centers to a private folder on their website using the same techniques as you 
use to publish your website.  There’s plenty of disk space.   

 The genealogist would also use FTP to download these files to their home computer 
once they get home. 

 The quick reference files that the genealogist needs on the trip could be accessed via 
handy hyperlinks from web pages on the website (we will return to this in a 
moment). 

Problems Using Your Genealogy Website 

 The major problem with using the hefty disk space of your website as a file storage 
resource is that FTP will be required to access it.  The use of FTP is often restricted at 
public institutions due to the security risk of downloading malicious programs or 
viruses.  

Your “Online File Folder” 

An “Online File Folder” is a service provided by www.genealogyhosting.com.  For a 
small yearly fee, you can have megabytes of disk space housed on our servers that can 
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be accessed via a web browser.  This is the best solution to the items on the list that 
require file storage.  An “Online File Folder” can be used to store and retrieve files at 
any research location.  It always works and doesn’t have any of the restrictions, 
problems or fiddle-factors of the other file storage solutions.      

Using your “Online File Folder” 

 The “Online File Folder” service is web-based and all that is required for its use is 
just a web browser.  Virtually all computers in research centers or libraries have 
computers with internet access so the “Online File Folder” is virtually always 
available and can be used without restrictions except as noted below. 

 Once you open your “Online File Folder,” it can always be used to upload files from 
any computer.   

 Also, you can always view a file  by right-clicking the file in the “Online File Folder” 
file list and selecting “view.”  This will open the file in the browser plug-in (if the 
browser plug-in for that file type is installed – otherwise it will offer to save the file 
on the field computer). 

Problems Using Your “Online File Folder” 

 However, you will probably not be able to save the file to the hard drive of the field 
computer in order to work on it directly.  This is due to FTP restrictions on the public 
computers in a particular library or research center. 

Implementing the Road Warrior Functions 
In this section, we will discuss how each of the requirements of the road warrior 
(defined above in  “What the Genealogist Needs on a Genealogy Trip,” page 2) can be 
satisfied.  We will recommend the use of some of the above resources (listed in “Trip 
Resources,” page 4) coupled with some easily completed preparations conducted prior 
to the trip.  The more time you can spend actually doing research on a genealogy 
research trip the better.  The less time you are distracted by your tool set the better.  Our 
philosophy in our recommended solutions is to keep it simple:   

 First, in general, we’re against depending on computer equipment on a genealogy 
research trip and we will not propose any computer equipment as any part of the 
solution in the discussion below.  We feel that there are always problems with the 
equipment in the field and the “fiddle-factor” alone makes computer equipment 
inefficient especially when compared with alternatives we will discuss below.   

 Second, what you need on a research trip is simplicity.  You need to be able to walk 
up to any computer you encounter in the field empty-handed and, using only your 
fingers and the mouse, have access to a reasonable replication of your computer-
based genealogy tool set.   

In other words, as much of your tool set as possible must be available via the internet 
somehow.  As we’ll see below you can implement much of the tool set using readily 
available internet-based resources when coupled with some easy trip preparations. 
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Requirement:  E-Mail 

The traveling genealogist must be able to access not only their normal e-mail account but 
also their address book in the field.  These requirements are fairly easy to satisfy.   

Internet Access to Your e-Mail Account 

When you register your domain name for your genealogy website at 
www.genealogyhosting.com, you automatically get a fully functioning e-mail account.  
We will assume you have already converted to this e-mail account since it is simple and 
incredibly effective.  All of our e-mail accounts are available from the internet as web-
based e-mail similar to an e-mail account at hotmail.com (as well as via a local e-mail 
application such as Microsoft Outlook Express).  In other words, your web-based e-mail 
can be accessed from any computer in the world that has internet access!   

Both options (web-based e-mail or an e-mail application) can co-exist.  That is, one can 
access their e-mail at home in the usual way using an e-mail application such as Outlook 
Express if they want.  Then when on a genealogy trip, they can access the same e-mail 
account using our web-based e-mail service.  

To use your web-based e-mail account in the field, walk up to any computer and:. 

 Start a web browser (e.g., Internet Explorer, Netscape Navigator) 

  Open your e-mail account by entering in the address bar the URL of the e-mail 
system: 

http://email.mywebsite.org (where “mywebsite.org” is your domain name) 

 Then enter your user id and password and you’re off and running. 

e-Mail Address Book 

You will need your e-mail address book on the trip.  If you are already using a web-
based e-mail account full time, then you’re set.  However, if your e-mail access is based 
on an e-mail application such as Outlook Express on your home computer, then an extra 
step is required.  Before you leave on the trip, you must export your address book from 
your e-mail application and import it into your web-based e-mail account at 
www.genealogyhosting.com.   

 Export your e-mail addresses (in the following, Outlook Express is assumed) 

o Start Outlook Express on your home computer 

o Invoke the export function of the address book 

o Select “Text File (Comma Separated Values),” then click “Export” 

o Click “Browse” and navigate to the target folder (where the exported address file 
will be stored).  Give the exported address file a file name that you can 
remember.  Click “Save” then “Next.” 
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o On the “Select the Fields you wish to export:” select First Name, Last Name, and 
E-Mail Address, then click “Finish” 

o The export proceeds to create a comma separated text file (CSV) of your e-mail 
address book. 

 Import your e-mail addresses to your web-based e-mail account at 
www.genealogyhosting.com 

o Start a web browser (e.g., Internet Explorer, Netscape Navigator) and open your 
e-mail account: 

http://email.mywebsite.org (where mywebsite.org is your domain name) 

(then enter your user id and password) 

o Access the Address Book import /export function (click and follow the dialog). 

o Browse to the exported address file that you previously exported (above). 

o Import it as a CSV (comma separated values) file 

o Set the fields to correspond to the exported fields 

First Name -> First Name 

Last Name -> Last Name 

E-mail Address -> E-mail Address 

o Invoke the import 

o At this point, your addresses are available in your web-based e-mail account at 
www.genealogyhosting.com. 

o Display your imported address book.  If it is not correct, it can be mass-deleted 
so you can start over with different settings, etc. 

Requirement:  Favorites 

Having access to your favorites (also called bookmarks) on the genealogy trip is 
mandatory since they drive much of your research.  Your favorites are located in your 
local web browser.  They can be easily exported to an HTML file and uploaded to a 
server on the internet to make them available to the traveling genealogist.  The export 
process creates the HTML file by inserting each favorite as a hyperlink under its 
corresponding folder in the favorites.  Since the favorites are then in the form of a 
standard HTML web page, the HTML web page can be uploaded to a server and opened 
in any web browser in the field.  Then the imbedded hyperlinks representing your 
favorites can be clicked like any other hyperlink on a web page to go to that website of 
that favorite.  In this way, you will have your favorites in the field! 
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Notice that we haven’t said what kind of server you will target.  As we’ll see below, 
genealogists can select among several servers to hold their favorites HTML file 
depending on how they want to use them.   

Exporting and uploading the favorites HTML file to a server on the internet requires 
these easy steps prior to the trip: 

Exporting Your Local Favorites to an HTML File 

Modern versions of both Microsoft Internet Explorer and Netscape Navigator can export 
the favorites (i.e., bookmarks) to an HTML file stored on the genealogist’s local 
computer which can then be uploaded to a server on the internet.  For example, in 
Internet Explorer, follow these steps: 

 Start Internet Explorer 

 Invoke the  Import / Export function 

 Follow the wizard to export favorites 

 Select the favorites folder to be exported (notice that if you don’t want to risk public 
access to all your favorites, you can select a subfolder). 

 Click “Browse” and navigate to an output folder on your local computer where the 
favorites file will be exported.   

 Specify the file name of the HTML file to receive the favorites, then click “Save”  

 Complete the Import/Export wizard:  Click “Next” then “Finish,” etc. 

 The favorites will be exported to the specified HTML file 

Using the favtool.exe Tool 

If the genealogist’s version of their web browser is old (more than 3 years old or is older 
than Internet Explorer 5), then it may not have this capability of exporting the favorites.  
In that case, the free utility “favtool.exe” can be used to export your favorites from either 
Internet Explorer or Netscape Explorer to an HTML file.  To use “favtool.exe” (i.e., 
which probably isn’t necessary if the genealogist’s computer is less than 3 years old or 
uses Internet Explorer 5.0 or higher) follow these procedures:   

 To get a copy of this free utility, do a search for “favtool.exe Microsoft” in Google 
then download it from the Microsoft recommended download site.   

 Once downloaded, favtool.exe can be executed on your local computer to create an 
HTML file of your favorites similar to the above.  To emphasize, this must be done 
from the your local computer where the favorites are stored (i.e., in the local web 
browser). 

 Actually, favtool.exe is very competitive with the export method described above 
and may be preferable even if exporting the favorites is supported in your web 
browser. 
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Uploading and Using the HTML Favorites File 

Once you have created an HTML file of your favorites (either by exporting them directly 
from your web browser or using favtool.exe), then the next step is to upload the HTML 
file to a server.  Which kind of server depends on how you intend to use it.  Since it is a 
proper HTML file, it can be opened and used like any web page.  Three options are 
available: 

 Standard Web Hosting (i.e., the disk space available on your genealogy website):   

If you already have a standard web hosting plan, such as our “Economy” hosting 
plan (either the free ad-supported or the purchased plan), to host your genealogy 
website, then you can upload your HTML favorites file in the usual way using the 
FTP capability (similar to the process of publishing your website).   

o Once uploaded, you can put a hyperlink to it on one of the web pages of your 
genealogy website.  

o An alternative is to open it directly when it is needed in the field using its fully 
qualified URL file name.  For example, assume that Margaret Schmidt’s HTML 
file is named “mybookmarks.htm” and it has been uploaded to the “utility” 
directory of her surname website www.schmidt14.org.  In this case, Margaret can 
open it by entering in the address bar of any browser: 

http://www.schmidt14.org/utiliity/mybookmarks.htm 

 “Online File Folder” (i.e., the service from www.genealogyhosting.com that provides 
internet disk space):   

o Use the “Add File” function to upload the favorites HTML file to your “Online 
File Folder” account.  Once uploaded, test it by clicking on it in the file list.  A 
web page of your favorites should open.  

o To access the HTML favorites file in the field just open it from your “Online File 
Folder.”  Just logon to your “Online File Folder” and double click the HTML 
favorites file from the file list.  It will open in the web browser you are using. 

o An efficient way to access the HTML favorites file is to put a hyperlink to it on 
one of your web pages.  The URL for the hyperlink will depend on your “Online 
File Folder”.  To determine the URL, double click the HTML favorites file from 
the “Online File Folder” and it will open in your web browser.  Once the 
favorites HTML file is open, the URL will be in the address bar of your browser.  
Copy it and paste it in your hyperlink. 

o Notice that using your “Online File Folder” makes your favorites HTML file 
password protected since you must respond to the password challenge of your 
“Online File Folder.”  Favorites are highly personal, often containing hyperlinks 
to your financial accounts, etc. (in addition to your genealogy sites) that should 
not be available to the general public.  However, you can avoid this problem by 
only exporting your genealogy tool set favorites instead of all of them when you 
create your HTML file on your local computer. 



 12 

©2007 www.genealogyhosting.com 

 “Website Tonight” (the easy-to-use, non-technical, template driven website 
authoring service available from www.genealogyhosting.com):   

If you choose the “Website Tonight” hosting plan (either the free or paid-for plan) to 
build a genealogy website (e.g., a genealogy workbench), then you will need to 
perform some extra tasks.   

o Unfortunately, for the genealogy road warrior, “Website Tonight” does not 
permit the uploading of HTML files.  This is because “Website Tonight” creates 
and controls all the HTML files of the website.   

o You would have to obtain another internet server then use it to upload your 
HTML files.   

o With this approach you would subscribe to an alternative server: 

•  Subscribe to an “Online File Folder” and use the procedures listed above 
(“Online File Folder”). 

• Subscribe to  a standard web hosting account and use the procedures listed 
above (“Standard Hosting Plan”).  Don’t forget that you get a free web 
hosting account with gigs of disk space when you register a domain name.   
So for the small yearly fee of a domain name, you would select a standard 
hosting plan as your free website to solve this problem 

Requirement:  Genealogy Database 

Using your genealogy database (i.e., the file from your genealogy software program) on 
a trip would ideally take the form of being able to open it directly from any computer in 
the field.  This means the genealogy database must either be available on a storage 
device such as a USB Flash drive or available from a server on the internet (i.e., prior to 
the trip, the genealogy database would be copied to one of these).   

But more fundamental is that the field computer must have the underlying genealogy 
software program installed.  For example, to open a PAF database, then the PAF 
genealogy software program must be installed on the computer in the field.  This is very 
unlikely in general. 

Let’s define what you are actually trying to accomplish with your genealogy database on 
a trip.  You generally don’t want to update your genealogy database on the trip – just 
open it in the field for quick references.  This is because it takes time and composure to 
make updates (which are in short supply on a genealogy trip).  You can wait and make 
your updates leisurely and methodically when you get home. 

You can view your genealogy database in the field by first converting it to HTML and 
then uploading the resulting HTML files (and possibly subfolders) and accessing them 
in the field using a standard web browser.  That is, you would use your genealogy 
software programs to export the genealogy database as a series of HTML files, in effect a 
“mini-website.”  It is a “mini-website” because it is a self-contained, independent 
website that can be uploaded to a larger website where it can be accessed.  Virtually all 
genealogy software programs can do this.  Once the “mini-website” has been uploaded 
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to a server, then it can be viewed from any computer you happen to be using on a 
genealogy trip using any web browser. 

The genealogy database “mini-website” can then be used as a quick-reference to the 
genealogist’s actual genealogy database (i.e., not the real thing but good enough for 
quick-references – and actually much more efficient for quick references because of the 
ability to navigate it as hypermedia using hyperlinks). 

• Start your genealogy software program and export your data as a “mini-website.”  
For example, in PAF, click “Tools -> Create Web Page…”  Be sure and select all your 
ancestors as opposed to selecting the “descendants” or “ancestors” options.  

• Alternatively there are many GEDCOM to HTML conversion programs.  GEDCOM 
is the universal genealogy file exchange protocol that all genealogy software 
programs can both import and export.  A GEDCOM to HTML conversion program 
can take the GEDCOM file exported from your genealogy software program and 
create a nice “mini-website.”    To find one, enter “Free GEDCOM to HTML 
Conversion” in Google and pick one that looks good.   

• In either case (i.e., genealogy software or GEDCOM converter), the resulting HTML 
files and subfolders are then uploaded to a server such as: 

o Your free or paid-for “Economy” hosting plan  

o Your “Online File Folder”  

o Not but not your “Website Tonight” plan explained below  

• The technique described above of uploading HTML files to the website would not be 
available for a “Website Tonight” website because “Website Tonight” does not allow 
HTML files to be uploaded to the website (i.e., The point of “Website Tonight” is to 
generate the HTML files).  However, the HTML files can be uploaded to a different 
internet server such as an “Online File Folder” or a standard hosting plan (which can 
be obtained free with the purchase of a domain name).  That is, you would use the 
technique introduced above of registering or renewing a domain name then select a 
standard hosting plan as your free website.  This would give you gigs of disk space 
and would completely solve this problem with “Website Tonight.” 

• Once uploaded to a proper server, the “mini-website” can be opened in the usual 
way via a web browser such as Microsoft Explorer or Netscape Communicator.   

• You can put a hyperlink to the home page of the “mini-website” on one of your web 
pages or you can open it directly using its fully qualified URL file name.  To 
determine the URL, open the “home page” of the “mini-website” in your browser.  
At that point the URL is in the address bar. 

Requirement:  File Storage 

There are several options available to saving files to a server in the field.  First though, 
why would you want to save a file in the field?  Let’s set the situation:  you’re in a 
research library using one of their CDs from their genealogy CD collection.  You find 
something so you want to save the current information on the screen.  You’ve already 
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collected a huge amount of paper on this trip so you don’t want anymore.  Instead of 
printing to paper, you want to create a computer file by saving it somehow and 
accessing it when you get home.  Let’s explore how you could do this.  

Your “Online File Folder” 

This is by far the most reliable method to save files from any computer you may 
encounter on a trip.  It is completely fool-proof and it is much more reliable then using 
any devices or equipment you might take on your trip, such as a USB Flash drive or a 
laptop.  All that is required is internet access.  You should think of your “Online File 
Folder” as an integral part of your traveling tool set and get good at using it.  With an 
“Online File Folder,” a work session in a library or research center might proceed as 
follows: 

 When you start your session on the field computer, open your “Online File Folder” 
in a web browser and have it sitting there waiting for your use. 

 Allocate a new folder on your “Online File Folder,” giving it a name representing the 
institution.  This will make it easier to understand its contents when you get home 
(actually you can do this in advance during your trip preparations). 

 When you encounter a file or information from an application you want to save, first 
save it to a local hard drive of the computer you are using.  You can almost always 
do this even in the most restrictive sites.  There is always some sort of temporary 
disk drive space available to the public. 

 Then go to your “Online File Folder” (i.e., which is already opened in a web 
browser) and click on the “Add File” button.  Select the destination folder (e.g., the 
one you previously allocated described above),  browse to the local drive where the 
file was stored above and select it.  Click “Start Upload” and it will be uploaded. 

 Check your work by opening the target folder on your “Online File Folder” and 
making sure it’s there, etc. 

Your Genealogy Website (Standard Hosting Plan) 

You could also use the disk space associated with your standard hosting plan (i.e., not 
the “Website Tonight” plan) as a file storage resource on a genealogy trip.  This is by far 
the quickest but also the most unreliable because many libraries do not allow the use of 
FTP:  

 At the start of your session, open up a Windows Explorer and access your website 
via FTP as you do when you publish your website.  This is very simple:  just enter 
ftp://www.mywebsite.org in the address bar and respond to the password challenge.  
It will either work or not in that institution. 

 If the institution permits the use of FTP on their computers (which is unlikely), then 
a Windows Explorer will open on the files and folders of your website.  Keep the 
Windows Explorer open to your website during your session and use it when you 
want to upload a file. 
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 Allocate a folder on the website corresponding to the institution (better yet, do this 
during your trip preparations). 

 When you want to upload a file, save the information as a file on the temporary 
drive space of the computer you are using in the field as explained above. 

 Open another Windows Explorer on the local folder where you saved the file. 

 Drag the file from the local to the website Windows Explorer window and drop it in 
the corresponding folder you have allocated corresponding to the institution. 

Requirement:  Quick Reference Files 

Here we’re talking about putting reference files on an internet server at home and 
looking at it in the field.  Why would you want to do this?  You will want to have your 
various special genealogy files created in various applications (e.g.,  MS Word, MS Excel, 
MS Works, etc.) available with you all the time on a trip. 

From Your Website (Both Standard Hosting Plans and a “Website Tonight” 
Plans) 

This is most efficient place to put reference files is on your website.  You would access 
them via hyperlinks: 

• Create your reference files in a common file format, such as Microsoft Excel, 
Microsoft Word, MS Works or as a text file. 

• While at home during your trip preparations, upload the files to your website”  

o For a standard hosting plan, use  FTP to upload the files. 

o For a “Website Tonight” hosting plan, use the built-in “Upload Files” (i.e., logon 
to the “Website Tonight” Site Builder, click “Build Web Site -> Upload Files”). 

• Then just put hyperlinks to the files in one of your web pages of your website.   

• When you are in the field, open your website and click on a hyperlink.  This will 
cause the file to either open or an offer will be made to download it, depending on 
the add-ons installed on the internet browser you are using in the field (browser 
add-on are software created by vendors and installed on the web browser to open 
and view files of the vendor’s application). 

• That is, if a browser add-on is not installed for that file type on the field computer, 
then a download of it will be offered.  However, restrictions at the local site will 
apply to downloading files like this.  Seldom will you be able to actually perform the 
download.  But you can definitely look at most files in the web browser using add-
ons which are always installed for all the popular file formats. 
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Your “Online File Folder” 

The above works great but it opens the file in a browser add-on.  Is it possible to instead 
open the file using its native application?  For example, if you were visiting your cousin 
and wanted to show her one of your genealogy files, then can you open it on her home 
computer?  Let’s say you have uploaded a Microsoft Excel file to a server and you want 
to open it in the application Microsoft Excel in the field and not in the Microsoft Excel 
add-on.  Is this possible?  The answer is generally yes (but FTP must be permitted) using 
your “Online File Folder” because any browser add-on won’t be invoked when you click 
the file in the file list.  Instead there will actually be an attempt to open it in its native 
application on the field computer.  However, the field computer must have the 
corresponding application installed and most public institutions will probably have 
restrictions on doing this. 

 At home, create your reference file in a common file formats such as Microsoft Excel, 
Microsoft Word, or ASCII text (which improves your chances that a field computer 
might have the corresponding application installed).   

 Upload the file to your “Online File Folder” at home.   

 When in the field, open your “Online File Folder” when you want to access the 
reference file: 

http://www.onlinefilefolder.com 

Then respond to the password challenge 

 Find the target file on the “Online File Folder” list and click it.  This will cause an 
offer to either open it or download it.   

 If you choose to open it and the local computer both permits it as well as happens to 
have the corresponding application installed, then that application will start and the 
file will open. 

 If you choose to download it, then FTP restrictions on the local computer will be 
triggered – you generally won’t be able to download it on most public computers. 

The Effective Road Warrior 
Here are some tips for being more effective and efficient when on a research trip.  These 
tips can be used to gain efficiencies and/or save time performing the various road 
warrior functions discussed above. 

“Website Tonight” and a Genealogy Workbench 

The genealogist can build their own highly customized genealogy workbench to provide 
the platform for implementing several of the above functions (defined in  “What the 
Genealogist Needs on a Genealogy Trip,” page 2).   

• An example of a genealogy workbench built with “Website Tonight” can be viewed 
at www.martygale.name.   
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• An overview of the “Website Tonight” service can be found at 
www.genealogyhosting.com. 

In summary, a genealogy workbench can be built using the “Website Tonight” web 
hosting service provided by www.genealogyhosting.com.  This hosting plan provides a 
template-driven, easy to use website building service that is designed primarily for non-
technical folks who wish to create a website.  However, just because it’s easy doesn’t 
mean it’s not powerful!  Also, when you register your genealogy domain name at 
www.genealogyhosting.com, you receive a free, five-page, ad-supported, “Website 
Tonight” website.  This would be perfect for building your genealogy workbench! 

A particularly useful aspect of “Website Tonight” is that the website is built entirely on 
the web via an internet browser, such as Internet Explorer or Netscape Navigator.  This 
means a genealogy workbench that is created under “Website Tonight” can be modified 
from anyplace in the world!  For example, when the genealogist runs across a useful 
research website while doing genealogy research in the Minnesota History Center, it can 
be easily inserted in a few minutes in his or her genealogy workbench right there in St.  
Paul! 

In this case, the genealogist would log on to their “Website Tonight” account from one 
of the many public computers at the  research center and insert the hyperlink in an 
appropriate place on the genealogy workbench, such as in a “My Genealogy Favorites” 
list on the workbench.  Then the genealogist would republish the site.  A few seconds 
later, the genealogy workbench could be reopened or refreshed and the new link would 
then be available! 

Protecting Your Favorites and Other Files from Prying Eyes 

The “Online File Folder” can also be used to implement a simple but very effective 
security system for your files requiring that the correct user id and password of your 
“Online File Folder” be entered to gain access to them.  For example, it would be 
common that you would not want to give the public access to your HTML favorites file 
(see above description).  Your favorites may contain private information such as the 
hyperlinks to your financial accounts. 

The solution is to put the files you wish to hide from the public in your “Online File 
Folder.”  Then when you’re on a trip, you would access the file by opening your “Online 
File Folder” button and responding to the password challenge.  Once logged on, you 
would click on the desired file to open it.  In the case of the HTML favorites file, it would 
open at that point like any other HTML file in the web browser as a web page on the 
computer you were using.  In this way, you are the only one who is able to see and use 
your HTML favorites at a slight inconvenience at the start of your session. 

Alternatively, you could put a hyperlink to your favorites HTML file on a web page of 
your genealogy website.  Then when the hyperlink is clicked, a password challenge 
would have to be satisfied to view your favorites file. 

You would probably keep the HTML favorites file open during your session, clicking 
the various hyperlinks you want to access as your session progresses.  Once finished, 
you would close the HTML favorites web page and log off of your “Online File Folder.”  
Also, note that the “Online File Folder” and the HTML favorites file are both opened in 
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their own web browser windows and are independent and either can be closed 
independently of the other at any time.   

Updating a File on the Server – Be Careful! 

When you open a Windows Explorer on the files and folders of a server (assuming the 
computer will let you), you are then working in a familiar environment.  Normally when 
you have Windows Explorer open you can double click a file and the native application 
of that file type will open.  For example, you can double click an MS Word DOC file 
which then opens MS Word.  You can proceed to update the MS Word file then save it. 

The question is how much of this open, update, save can you and should you perform 
on a server-based file?  For example, you may be able to open a Windows Explorer on 
your server-based files located on your standard hosting website in the field.  Once 
opened a list of files and folders on the server will be displayed.  Let’s say one of them is 
an MS Word.  Can you just double click it, open MS Word, update the file, and save it 
back to its original location which happens to be a server instead of your normal local 
hard drive? 

This is a bad idea!   First, you may get interrupted at anytime since the network is not as 
reliable as your local hard drive.  Second, the correct application (in this case Microsoft 
Word) may not open but rather the browser add-on.  Third, you don’t really know 
where you stand in these file operations (open, save) during network delays, etc.   

A safe and predictable way to update a file on the server is to first download it to the 
local computer for example by dragging it to a local folder.  That is, if the field computer 
allows you to open it, then it will usually let you download it.  Then update this local 
copy of the file.  For example, if it is an MS Word file, then once downloaded, proceed to 
open it and update it in MS Word on the field computer.  When finished with your 
updates, then drag it back to its home on the server.  Of course all this depends on the 
ability to use FTP on the computer which is often not possible due to the security risks of 
FTP in downloading or opening a server file. 

Organizing the Files on the Server 

When you are on a genealogy research trip, you will be collecting a lot of genealogy 
information and uploading files to folders on the server.  You will want to organize your 
folders on the server so that you can quickly upload files but also understand what you 
have when you get home.   

You can get and stay organized by using folders with the names of the topics you are 
researching on the trip.  For example, while still at home during your trip preparations, 
build a folder for each topic you will need on the trip on the server (i.e., whichever 
server(s) you may be using).  For example, if you are using an “Online File Folder,” you 
can build them quickly using the “New Folder” button.  Similarly, if you are using your 
standard hosting disk space, you can build the folders using Windows Explorer in the 
usual way.  For example: 
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 Build a folder for each of your 12 unique surnames of your “Big-8” (your great-
grand parents). 

 Also, build a folder for each library or research center you will be visiting.  For 
example, if you are going to the Allen County Library in Fort Wayne, Indiana then 
set up an “allen” folder on the server.  Use these library folders to upload those 
miscellaneous files found at that library that aren’t related to a specific surname.  

Use your Genealogy Website for Quick Reference 

When you are in the middle of researching a topic at a library, you often need to lookup 
little pieces of information quickly – a date, a name, an event.  Since most public libraries 
and archive centers have computers with internet access, your up-to-date genealogy 
website itself can satisfy much of these quick reference lookups.  After all, it contains the 
essence of the information that is in play in your current genealogy research and will 
thus be readily available via any web browser. 

Before embarking on your genealogy trip, make sure your genealogy website is up-to-
date with your most recent facts and detailed information.  Then when needed, your 
genealogy website can be used for these quick references.  Within seconds, you can open 
your website and go to the web page containing the information.   

Daily Discipline:  Upload the Contents of Your USB Flash Drive 
and Digital Camera to the Server 

When you are on the trip, frequently upload any files you have saved on your USB flash 
drive to the server.  Also, do the same with your digital camera photos.  If you lost the 
little USB flash drive or your camera, you would loose the valuable information on it.  
Establish a regular discipline of uploading everyday.   

The constraints of using FTP discussed above may apply but you can always upload to 
your “Online File Folder.”  Also, you can often perform these uploads back at the 
hotel/motel using the lobby computer which seldom has the same security safe guards 
of the public computers in the various institutions you visit.  Don’t forget to bring along 
your own USB cable! 

Save Print Files as PDFs, then Upload Them 

This is a very efficient way to capture print files.  Rather, than print them at the library 
and have to carry some more paper home, turn them into PDFs and upload the PDF file 
to the server.  Unfortunately this is unreliable because many public computers in the 
field do not have a PDF print program installed.  A PDF print program creates a file in 
Adobe PDF format rather than printing it as hardcopy.  Also, many institutions do not 
permit the use of FTP on their computers anyway (but an “Online File Folder” will 
always work).  However, it’s worth a try so here are the procedures to create and upload 
a PDF file! 
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• Click “File -> Print” from any application on a field computer.  Select the PDF print 
program (if available) such as the free “CutePDF” that happens to be installed on the 
computer and save the PDF file to the public disk space on the local hard drive.  

• Then upload the PDF file to the server.  If you have a “Online File Folder,” use it 
since it’s fool-proof.   

• Otherwise, open up a Windows Explorer and access your website via FTP.  Maybe, 
you’ll get lucky. 

o A Windows Explorer will (hopefully) open on the files and folders of your 
website. 

o Open another Windows Explorer on the folder where you saved the PDF on the 
public space of the filed computer. 

o Drag the PDF from the local to the website Windows Explorer window. 

Preparing Your Server Files for the Genealogy Road Trip 

Prior to embarking on your genealogy research trip, you should spend some time 
thinking about what computer resources you’ll need.  Then you should make sure you 
have them for the trip.  Many of these resources will be files that you will upload to a 
server prior to the trip.  Here is a check list for preparing for a genealogy trip: 

 Upload your address book (if you use an e-mail application such as Outlook 
Express) to your e-mail account at www.genealogyhosting.com as explained above in 
“e-Mail Address” on page 8. 

• Upload your favorites as explained above in “Requirement:  Favorites” on page 9. 

• Upload your genealogy database (i.e., from your genealogy software such as PAF, 
TMG, Legacy, Family Tree Maker, etc) as explained above in “Requirement:  
Genealogy Database” on page 12. 

• Export and upload the HTML version of your genealogy database (the “mini-
website”) exported from your genealogy software program as explained in 
“Requirement:  Genealogy Database” on page 12. 

• Export and upload your GEDCOM file from your genealogy software program. 

• Upload any quick reference files you use in your research (e.g., Word documents 
from cousins, maps, Excel files containing reference lists, etc.). 


